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Extension of the Commissioning

Reading/Writing of variables in the editors of the free configuration

Z-19350

Z-19351

For the sake of quick commissiong of projects with free configu-
ration, directly access to the variables of a coupled controller in
the editors of FBS and IL can be gained without having to state
these in the value window of the commissioning feature.

There are 2 possibile selection methods:

Firstly, you can select a variable of your choice (with a simple
click on the variable) and then call up the function “Read/write
variables” in the “Edit” menu, in order to display the selected
read value online.

After choosing the variable, the function key <F7> can also be
used for accelerated selection.

The second possibility involves calling up this menu item or the
accelerated selector without previously selecting a variable.

In both cases, a window containing all variables used in the pro-
gram - both user-defined and predefined - is displayed. The vari-
able to be read online can be selected from this list. If a variable
had been previously selected, this shall be displayed with its data
type and online value. The contents of the window correspond to
those in the window of the variable list for commissioning.

The value is constantly updated. Within the list, changing over to
another variable is possible at any time. This selection can also
be made using the <↑> and <↓> keys.
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Access to controller via modem

Z-19352

A modem connection can also be used to gain online access to
the unit. With it, systems can also be commissioned without
being on site. No PC is required on the controller side for this
type of communication. The modem can be operated directly with
the connected controllers. Should more than one controller be
connected, the RS-232 interface of the modem must be adapted
to match to RS-485 with the help of an adapter.

The telephone connection via modem can be established and
controlled directly via IBIS_R+. Additionally, the IBIS_R+ also en-
ables the application of a telephone directory.

In order to configure the modem connection, the “Communica-
tions Parameter” dialog must be called up.

In the field marked “Connections”, indicate whether a modem can
be used for obtaining the next online access by ticking off. This
setting remains valid until the next change, if the dialog is termi-
nated with [OK]. A modem connection can only be established
via an apparatus equipped with an interface module. Modem
ope-ration via the TTL interface is not possible.

If a modem connection was ticked off in the given field, the “Mo-
dem” becomes activated. In it, a name for the system to be ad-
dressed should be selected from a list. This list represents a tele-
phone directory. The appropriate telephone number and the
name itself can be input or modified here. If a name or telephone
number was input or modified, this can be stored in the tele-
phone directory by pressing [Save subscriber]. Selected names
can be deleted again from the telephone directory, including their
corresponding numbers, by pressing [Delete subscriber].

The H-288e made by Messrs Häussler has been set at the fac-
tory. If new settings are required for a different modem, this
should be changed via [Configure modem]. The appropriate pa-
rameters for telephone dialing can also be set in the same way.
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Z-19353

The basic parameters for creating a telephone connection can be
entered into the “General” field. The selection of either tone or
pulse is determined by the type of telephone system used on the
PC side. If the type used is unknown, contact the manufacturer.
The “Maximum time for dialing” is the time required by the mo-
dem on the controller side to respond after the modem has been
dialed, e.g. through a call for start-up via modem. If the modem
responds, communication is exchanged between the modems on
the type of data connection to be made. This must be achieved
within the time frame “Maximum time for establishing a connec-
tion”, otherwise the entire dialing exercise shall unsuccessful and
subsequently be aborted.

In addition to the general parameters, the “AT command sequen-
ces” for controlling the modem on the PC side for initialization,
dialing and engagement can be configured. These settings can
be accepted into the INI file of IBIS_R+ by pressing [OK]. If modi-
fications must be made in order to match to other modems, such
modifications are normally indicated in the manual of the modem
in question. For operation with IBIS_R+, a synchronous data
operation must be configured.

The modem H-288e made by Messrs Häussler has been set at
the factory. These settings can be called up at any time by pres-
sing [Standard] in the input windows of the “AT command se-
quences”, and the required inputs of the INI file can be over-
written by quitting the dialog with [OK].

Information required for operating the modem is also provided in
the lower part of the dialog. The most important information is the
maximum baud rate required for the modem. Since data is trans-
mitted on the telephone line with a double baud rate for addres-
sing the PC or controller, this fact must be taken into account
when applying the IBIS_R+ and the controllers. The baud rate
applied in the controller configuration for the RS-232 or RS-485
module and the baud rate set in the communications parameters
of IBIS_R+ must be identical and less than or equal to half of the
maximum permissible baud rate. When using modems with a
maximum baud rate of 28.8 kBaud, this amounts to 9600 baud
for the controller, since 14.4 kBaud is not available for selection.

The dialog for configuring the modem can be quit with [OK] - all
modifications made shall be saved - or with [Cancel] - all modifi-
cations made shall be rejected.

If the modem is used for the uploading or downloading of con-
troller information or for commissioning, there will be an auto-
matic query as to if the established telephone connection should
be maintained when quitting this program section. Yes means
avoiding delays in making new connections. However, keeping
the line means incurring extra telephone costs. If the connection
is to be initially kept and interrupted later, this can be done in the
program section called “Project management” via→Project→Close
modem connection.

If modems are operated on transmission paths, the modem on
the controller side should be configured before connections are
established - normally before being supplied to the end user. The
instructions on how to do this are supplied in the modem manual.
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Operation of programmer parameters

Z-19354

During commissioning, the list of parameters of the respective
program for the programmer can be called up for parameter in-
puts, in addition to the parameters of the just selected control
loops or of the unit, with →Signal window→Parameter list→Pro-
grams. Following this, the usual dialog with which parameter lists
can be selected and modified is displayed, the appropriate va-
lues being then transmitted to the coupled controller.

Up and downloading

During display of the process sequences for the uploading and
downloading of projects, a motioned graphic is windowed.

New predefined variables

Newly predefined variables are introduced with the library 3.5.0.
These are variables of the data type INT and variables for the
display of alarm pointers in the bar diagrams of Protronic 550.

Name of variable Significance

.INT_01

.INT_02 to

.INT_32 Variables (INT) for interconnecting customer-specific data are provided in the free configuration. Since
the variables can be addressed via the Modbus-RTU and Profibus-DP protocols, these can be em-
ployed by systems to gain access to Protronic 500/550 and Digitric 500 data which cannot be numeri-
cally processed in REAL.

.L1_GWMAX_GRAPH Contains the normed value (REAL) of the upper (maximum) alarm threshold for the bar diagram with
number 1 of Protronic 500. This represents the control variable, except in the case of ratio control.
Value range: 0.0...1.0.

.L1_GWMIN_GRAPH Contains the normed value (REAL) of the lower (minimum) alarm threshold for the bar diagram with
number 1 of Protronic 500. This represents the control variable, except in the case of ratio control.
Value range: 0.0 ... 1.0.

.L1_VGWMAX Contains the value (REAL) of the upper (maximum) alarm value pointer in physical units for the ratio
in the case of ratio control. When using ratio control and depicting the actual ratio as bar diagram, this
value is displayed as an alarm value pointer via .L1_GWMAX_GRAPH.

.L1_VGWMIN Contains the value (REAL) of the lower (minimum) alarm value pointer in physical units for the ratio in
the case of ratio control. When using ratio control and depicting the actual ratio as bar diagram, this
value is displayed as an alarm value pointer via .L1_GWMIN_GRAPH.
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.L1_XGWMAX Contains the value (REAL) of the upper (maximum) alarm value pointer in physical units for the first
used maximum alarm value of the control variable.

.L1_XGWMIN Contains the value (REAL) of the lower (minimum) alarm value pointer in physical units for the first used
minimum alarm value of the control variable.

.L1_YGWMAX Contains the value (REAL) of the upper (maximum) alarm value pointer in physical units for the first
used maximum alarm value of the output variable. The alarm value pointer would be windowed for
alarm value used in the bar diagram bearing the number 3. Value range: -5.0...105.0.

.L1_YGWMIN Contains the value (REAL) of the lower (minimum) alarm value pointer in physical units for the first used
minimum alarm value of the output variable. The alarm value pointer would be windowed for alarm
value used in the bar diagram bearing the number 3. Value range: -5.0...105.0.

This is also true for the alarm value pointer of the control loops
2, 3 and 4, as far as variables .L2_GWMAX_GRAPH to
.L4_YGWMIN are concerned.

The alarm value pointers for the bar diagram number 1 are faded
out when both .Lx_XGWMAX and .Lx_VGWMAX accept the va-
lue 100000.0 as the upper alarm value pointer. This is true for
the lower alarm value pointer when both variables .Lx_XGWMIN
and .Lx_VGWMIN accept the value -100000.0.

Should any of the variables have a value which is not equal to
the stated control value, the alarm value pointer mark shall be
displayed.

This also applies to the alarm value pointers of the bar diagram
number 3 for the control variable. However, everything refers to
the variables .Lx_YGWMAX and .Lx_YGWMIN.

Extension of the standard generation of alarm pointers

With the introduction of the alarm value pointers for the control
variable, actual ratio and output variable in the library 3.5.0 this
means they are integrated into the standard generation routine.
Compared to library 3.4.0 this would lead to a change of the FBD
programs Lx_GRENZ4 and the introduction of new FBD pro-
grams Lx_GW550. In accordance with the list configuration there-
fore, the variables to be used for Protronic 550 have been cor-
rectly assigned to the alarm value pointers.

If a configuration from a library 3.4.0 is to be exported or accep-
ted earlier, it is recommended to add an interconnection of the
new variables. Unused maximum alarm value pointers should
then be set to 100000.0 and the minimum alarm values to
-100000.0.

Fading out bar diagrams

When applying the firmware for Protronic 500/550, Digitric 500 or
higher, using library 3.5.0, the bar diagrams for the control vari-
able, the set point and the output variable can be faded out
(dark) individually.

To enable this, the value of variables .Lx_XANA_SKAL,
.Lx_WANA_SKAL and .L1_PID_Y_OUT must be set lower than
or equal to -100.0.

Library management

Beginning with the IBIS_R+ Version 1.00.0350, it is also possible
to use the library 3.4.0 to configure controllers equipped with a
firmware version current enough to match a new library.

However, only the functionality of library 3.4.0 in the new con-
trollers are utilizable, but not the extended functionality which led
to the new library 3.5.0.

New modules such as the Profibus-DP slave or the frequency
input module cannot be configured with it, since unknown to the
library 3.5.0, even if the configured unit could process these. In
like manner, the new variables introduced with the library 3.5.0
cannot be used.

Use of dongles

In this new version the dongle is only required for conducting
verification. With it, list configurations for the control of internal
wirings leading to the free configuration can be converted.

It is also possible to edit and store free configurations without
dongles.
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Extension of documentation

Foot of drawing

Z-19355

Z-19356

The documentation module provides the possibility to display bit-
maps in the plotted windows (Windows *.BMP).

This can be done by using →Project→Project-head→Edit drawing
footer in the project manager or →Edit→Head→Drawing footer in
the project tree to fill the existing 3 fields with the required
information. It is in these fields, as suggested in the figure, that
the name of a bitmap can be input. In order to differentiate the
text input, prefix the name with #.

Since no absolute directory path can be stated, the bitmaps used
are taken from the directory \IBIS_R(P)\ BITMAPS. This directory
is generated automatically upon installing the software. Please
store all used bitmaps in the aforementioned directory before
generating a documentation. If a required bitmap is not stored in
this directory, the bitmap name with preceeding “#” is printed
instead.

List configuration

Z-19357

The documentation of the list configuration offers the possibility
to print out only deviations or modifications from the factory set-
ting. This enables the compilation of a very abridged and concise
documentation, which only contains data on the most important
and modified catalogs.
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Z-19358

Z-19359

This type of documentation can also be used for making long
documentations, whose question and response texts are also to
be printed out.

In order to utilize these possibilities, select “Deviations from de-
fault settings only” from the list data of the documentation
module.

Hardware configuration

Z-19360

The documentation of the hardware configuration also permits
the printout of interconnected displays stored in the hardware
configurator for the modules, instead of a simple display of a
unit’s listed configured modules.
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Z-19361

In order to utilize this possibility, use the hardware assignment to
select “with connencting diagrams” in the documentation module.

Using IBIS_ R+ with Windows 95
When using Windows 95 to download a configuration, an error
message to the tune that parts of the configuration (“Domains”)
are not fully loaded could be displayed.

This error can only be remedied by changing the basic settings
of the used COM interface in the system control.

By following the steps below, the basic settings can be so modi-
fied that the reported error can be prevented.

[Start]
→Settings
→Control Panel
Double click “System”
→Device Manager
Swing open Ports (COM and LPT) with [+]
Double click the used COM interface
→Port-Settings
→Advanced

Read the descriptive text in the displayed dialog and set the
transmit buffer to “low” (1). Upon completing the dialog, the error
normally ceases to occur when downloading.
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